
English Top Next

for add keys send it to plcsim@mail.ru, plcnetru@mail.ru

This program is not designed for use at work place - in an age of Stuxnet can not trust 
anyone, and under the guise of this program, you can slip the malicious program.

Sometimes I think I created a monster - do not put the keys in the industrial facilities!
v2012.03.08 For testing Innovation tour training TIA Portal V11 and PCS7 v8.0
1515 keys

PCS7 v8.0 and key9999

Problems with new ALM v5

Simatic IT Business Objects Enterprise signed keys

Official FAQ

FastCopy keys v3.0

v2012.03.08 add some info for PCS7 v8.0.
v2012.02.26 add some info for WinCC Flexible 2008 SP3, Simatic Net v8.1. Fixed bug of euristic engine.
v2012.01.26 add some info for Simatic Net v8.1
14/05/2011 add some info for Innovation tour training  V11
15/02/2011 This internal version for testing add some keys
11/10/2010 add some info for....
10/10/2010 add one info for "SIK/ SIMATIC S5 PMC IE V7.0" ("A9S5IE70") 
09/09/2010 add some info for WinCC DowntimeMonitor, WinAC, fix bug for comp and Virtual Machine with 1 HardDisk partition

09/05/2010 add keys for WinCC Flexible 2008 SP2 options v1.3, Sinaut, fixed one ALM v5 bug
20/04/2010 add some keys Safety Matrix, PCS7 powerrate, PCS7 CFC AS RT SIFPZASRPX9999A
20/03/2010 add some keys, "option Recommended" and info about closed PLC.NET.RU and reopened http://plcforum.uz.ua
26/08/2009 add keys for TIA Portal v10.5, Braumat, Maintenance Station 2009
04/04/2009 add keys for WinAC MP 2008, PCS7 v7.1
22/12/2008 add keys for WinAC 2008, Simatic Net 2008, RF-Manager 2008
20/08/2008 add keys for WinCC Flexible 2008
24/07/2008 Open FastCopy v3 key option
21/07/2008 add keys for WinCC v7.0
29/06/2008 add keys for PID Tools v5.2, D7-SYS v7.0, PowerControl, RF-Manager
14/03/2008 add keys for Simatic IT and multikey description
23/02/2008 add keys for CEMAT v7.0 , WinCC v6.2 and PCS7 v7.0
18/02/2008 add keys for Simocode 2007
15/02/2008 add keys for DocPro 5.4, WinAC MP 2007, Soft Starter 2007  and fix error for "New" folder07/12/2007 add keys for Sinema E 2006 and fix error for Motor Starter 
2007 (but add bug - not install keys from "New" folder)
30/11/2007 add keys for Motor Starter 2007, Net 2007
27/11/2007 add keys for SmartLabel v3.0 HF1, WinAC/RTX 2005 SP3
07/11/2007 Add and change some Tags keys for WinCC v6.2 and PCS7 v7.0
As it in a stage of development some functions can be not completely accessible or be carried out with flaws
Direct record on a hard disk and Flash memory works. On Flash memory long keys - the list some minutes enter the name only
It is necessary to add direct record of keys on a diskette
It is necessary to correct for the list of keys
In the previous versions there were problems with some short licenses ( WinAC, SmartLabel ).
In the given version the part of problems is solved.

In far, far years Siemens has charged development of protection for the software products to StopCopy corporation. That has developed protection on the basis of the key files 
placed on special image to the formatted Yellow diskette - from here and the name.
Thus affirmed, that protection up to that is reliable, that " it will be reliable to preserve your investments ".
Big human thanks experts StopCopy for the done operation in the field of creation of an atmosphere of availability of products of Siemens to broad masses of programmers. It 
has made program and hardware solutions very popular and demanded worldwide, that has allowed to compete adequately to other manufacturers of automation even in their 
territory. To take for an example of the USA with and them B&R and General Electric... And accordingly has really saved up the nested investments. In fact iron equally should 
be bought all from Siemens.

The given program is intended for installation of keys of licenses in case of, when:
There has occurred " a rainy day of the programmer " - the system has flied together with all authorizations, and to work it is necessary, even in remote areas;
When there was a new hot product, and the heads yet does not give money for it.
Simply you wish to study for the general development.

It is developed in connection with release of version ALM 3.0 - the Authorization Licenses Manager after whom, so-called, "fastcopy" long keys of authorization have ceased to 
work because of their ignoring by this Authorizator.
"Fastcopy" keys could be copied simply in the directory of licenses C: \AX NF ZZ. They used auxiliary "hole" in system of authorization ALM <v3.0 which have been covered 
with output Step7 v5.4 SP1. 
Also additional coding the keys, therefore new keys have been applied are not visible in ALM v2.2.
New keys are incorrectly displayed in old versions of programs EKB_Rename, EKB_Backup and in EKB_Install <v.2007.03.03
and are not visible in ALM v1 and v2.

I do not call to use a software of Siemens in the mercenary purposes. Programs for the industrial purposes basically should be pawned in estimates of projects and be gained 
on money of the customer.
Very few people will come in a head to put the customer left PCS7 with the left keys and without the certificate on large production.
And for house usage probably there is nothing worse fuss with license diskettes. There were cases when the worn out firm Yellow license started to be showered for Intourist 
with miss of keys in far remote places without phone and the Internet.

I recommend to buy from Siemens Premium Studio 2008 for 90 euros for acquaintance with Simatic programs
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Introduction Top Previous Next

The Main Window comprises the following buttons and fields:

Tree with the list of programs and the table with the list of keys
Field for a conclusion of comments and the help information
Line of a choice of language of the interface
Line of a choice of a disk for installation of keys and the button of updating of the list of disks
Lines of input of serial numbers
Line and the button for search of a key by the set word
The button of a call of a window for work with images of Yellow diskettes
Field of a choice of preferences of type of the license at installation
Buttons of installation short, long or all chosen keys
Select key types for install

How can you deactivate the Trial License when the message appears indicating that the Trial License has expired, although the Floating License has been 
installed?

Install short key from old Siemens.exe
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What is the difference between authorizations and license keys? Top Previous Next

What is the difference between authorizations (AuthorsW short keys) and license keys (ALM long keys) ?

http://support.automation.siemens.com/WW/view/en/19020864

Configuration Notes:
License keys are the new authorizations as from STEP 7 V5.3. With the new license keys we are implementing a new concept in the licensing of SIMATIC 
software. 

Whereas the authorizations up to and including STEP 7 V5.2 were valid only for a specific version of the software, the license keys as from STEP 7 V5.3 are 
automatically also valid for the earlier versions of the same software. 

This validity however is restricted only to the programs that are licensed with the license keys. 

For programs licensed with an authorization only the authorization valid for the version continues to be valid. 

Another new feature is that license keys can be stored on a network driver and can then be used by various computers (floating license). 

The options that the SIMATIC world makes available to you with this type of licensing are described in Entry ID 19021092. 

You can tell from the license number whether a program is protected by an authorization or by a license key. The license number is shown in the Automation 
License Manager (ALM). 

An authorization license number has ten digits, a license key license number has twenty digits. 

Whereas there were earlier only authorizations and emergency authorizations, there are now the following different types of license keys.

Notes on authorizations (AuthorsW short keys):
Authorizations can only be saved and repaired on the original yellow or red floppy disks and installation is only possible on internal hard disk drives and 
partitions or network drives, but not on USB sticks. To ensure working with the associated software the authorization must be available locally on the hard disk 
on which the software is installed. Authorizations cannot be transferred via the Internet nor installed on USB hard disks.  There is an emergency authorization 
X*.EKB on Red or Yellow floppy disk

Notes on license keys (ALM long keys):
License keys cannot be restored on the floppy disks on which they were supplied, but can only be repaired on the PC/PG on which they are actually located. 
There is no longer an emergency authorization on floppy disk for license keys, because the software is always runnable if a valid license key has already been 
installed. So if there is a defective license key on the hard disk, working with the software is only interrupted at regular intervals with a message informing you 
that there is no valid license key available. As from ALM V1.1 SP1 you can also store license keys on USB sticks. A Trial License Key is installed from the CD. 
It can be activated via the actual SIMATIC application once for 14 days and is for evaluation purposes. You cannot restore or move the Trial License Key. 

Software products that are released for utilization with license keys can also use newer license keys. More information on this is also available in the Online Help 
of the Automation License Manager under 

See also: Type of  key

· Notes on utilizing "older" software versions.

We shall install keys later Top Previous Next

During installation of programs Simatic it is refused installation of keys.
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Language Top Previous Next

Select one of the available languages in the drop-down list box.

Required keys Top Previous Next

The list of necessary keys for the installed programs.
But this list is not full ! 
"I don't know all you fantasies..."
Some programs also required others keys !
From tag keys install only one with necessary quantity of tags (an example for CFC in figure).
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you can view only recommended keys

Recommended Top Previous Next

you can view only recommended Required keys
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Missing keys Top Previous Next

You can specify names of missing keys in the manager of licenses ALM

Bundle keys Top Previous Next

Complex key S7PROF* for professional version STEP7 can be used instead of 4 separate keys A17104 *, A1PLC_ *, A1S7GR *, A1SCL_*.

SIFLS7PROF1100.EKB  STEP 7 V11 Professional combo keyfor use with STEP7 Professional version v5.5 and v11.0

SIFLA9XEP11100.EKB WinCC flexible Advanced combo key for use with WinCC flexible 2008 and WinCC Advanced v11.0

Key PCS7TT* for program PCS7 can be used instead of the whole complete set of keys. 
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Displaying the Installed License Keys Top Previous Next

Displaying the Installed License Keys
You can view all installed license keys using the line "Installed only" in the tree view
or select the drive in the list

Seletct key Top Previous Next

For a choice of a key press on Check Box.
Repeated pressing will cancel a choice.
For a choice of all keys in current section press Check Box in the first line.
Repeated pressing will cancel a choice in current section.
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Find key Top Previous Next

Full-text search is a search for a word or a word combination through the complete text of all entries in the database.
Type the necessary word or word combination in the Edit line or copy them from the Clipboard and click "Find key" button. 
For example: 

The table displaying the list of entries containing the search pattern you entered.

I always use this option

· part of key name Step or Step prof
· part of filename s7prof
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Unknow keys Top Previous Next

Example of new keys after installation of new programs.

Popup menu Top Previous Next

You can:
· Copy text to clipboard
· Save the current table
· Create Yellow Disk image file with 1 key

FastCopy keys v3.0 Top Previous Next

Second generation of LONG FastCopy license keys anew work with ALM v3 and ALM v4.0

"Fastcopy" keys could be copied simply in the directory of licenses C: \AX NF ZZ. 
"Fastcopy v1" used auxiliary "hole" in system of authorization ALM <v3.0 which have been covered with output Step7 v5.4 SP1.
It is developed in connection with release of version ALM 3.0 - the Authorization Licenses Manager after whom, so-called, "fastcopy" long keys of authorization have ceased to 
work because of their ignoring by this Authorizator.
"Fastcopy v3" work without problems with ALM v3 and ALM v4.0.

Only FastCopy key from EKB_Install is realy FastCopy key.
"Fixed" and "FastCopy" key from EKB_Backup (by Fubrus) have bugs.
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but wait ALM 4.1

Installing License Keys Top Previous Next

You can install one key or group of the chosen keys on the specified flexible, rigid disks or external USB a disk (Flash stick  or Flash card in cardreader).
Thus there are some variants. 

It is possible to choose one of variants of installation chosen keys:

Select type of keys: Float, Single, Rental, Long, Short

Thus on the button of the general installation the picture according to a choice varies.

If you connect or disconnect replaceable carriers during work of the program for updating the list of carriers{bearers} press the button " To update the list of disks ".
Again connected carrier will appear in the list.

After installation corresponding names of keys will be painted

If the key is already installed on a disk there will be a window with the request to confirm installation atop of available.

[****]

1. All - short and long
2. Only long
3. Only short
4. Installation with preference:

• Are installed long and if is not present long for the chosen type of the license the short variant of a key is installed.

• Are installed short and if is not present short for the chosen type of the license the long variant of a key is installed.
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See Check of keys after installation
[****]

Old Siemens.exe Top Previous Next

For installation of short keys from a set it is possible to use program Siemens.exe.
Copy in the catalogue with the program demanded keys (no more than 100 keys lumpsum) and start the program.
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If in the catalogue with Siemensexe there are no keys at start the following message will be show.

Type of key Top Previous Next

Licenses in the Automation License Manager

The standard license types and license types listed below are available:

Standard License 
Types

Description

Single license

SISL*.EKB

and all short keys
 (not X*.EKB)

Use of the software with this license is permitted on any 
one computer for an unlimited period. The type of usage 
is defined by the certificate of license.

Unlimited use on any one 
computer.

Unlimited by time

Count tags relevant license

Floating license

SIFL*.EKB

Use of the software with this license includes right of 
use for simultaneous usage for an unlimited period. The 
software can be installed at multiple locations.

Unlimited use on any one 
computer or via the network.

Unlimited by time

Count tags relevant license

Count relevant 
license

SIFC*.EKB

Use of the software with this license is limited to:

· The number of tags stipulated in the agreement 
Count tags relevant license

Rental license

SIRT*.EKB

SIMF*.EKB

Use of the software with this license is limited to:

Note: the time remaining for the rental license is 
indicated in the information area of the tooltips taskbar.

· The number of hours stipulated in the agreement 
SIMF*.EKB

· The number of days after first use as stipulated in 
the agreement SIRT*.EKB

Limited use as stipulated in the 
rental contract.

Limited by time:

1..50 hours

1...N days

To install 365 days Rental keys: 

Limited use (max. 14 days) for 
tests and for validating (with 
disclaimer).

Limited by time = 14 days
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Missing license key 

A license key that is required by the software but is not available in a "valid" form on the network is designated as a missing license key.

Trial license

SITT*.EKB

Use of the software with this license is limited to:

· A validity period of, for example, a maximum of 14 
days.

· A specific number of days after first use

· Use for testing and validation (excludes liability)

Count tags relevant license

A SITT*.EKB Trial License Key 
is installed from the CD. 

It can be activated via the actual 
SIMATIC application once for 14 
days and is for evaluation 
purposes. 

You cannot restore or move the 
Trial License Key. But...

emergency 
authorization
X*.EKB

Use of the software with this license is limited to:

· A validity period of, for example, a maximum of 14 
days.

· A specific number of days after first use

· Use for testing and validation (excludes liability

License Types Description

Unlimited license Use of the software with this license is unlimited.

Count relevant 
license (Tags)

SIFC*.EKB

Use of the software with this license is limited to:

· The number of tags stipulated in the agreement (for 
WinCC, PDM, CFC and others).

· The number of PowerObjects (PO) stipulated in the 
agreement for PCS7 v7. PO ~ Tags

SIFCY9WTGX06001

Pay per use 
license

SIFP*.EKB

Use of the software with this license is limited to the 
use conditions stipulated in the agreement.

Number of Clicks !?

SIFPZASRPX99991

Demo license

Use of the software with this license is limited to:

Note: the time remaining for the demo license is 
indicated in the information area of the Quick Info 
taskbar.

· The number of hours stipulated in the agreement 

· The number of days after first use as stipulated in 
the agreement

Contract license Use of the software with this license is unlimited.

Upgrade license

SIUP*.EKB

SIPP*.EKB

An upgrade may call for specific system status 
requirements:

· An upgrade license enables you to convert an "old" 
version V to a version >V+... license.

· An upgrade may be required, for example, if you 
wish to increase the number of computers running 
an application.

Keys for updating the license consist 
of two keys *.EKB and *.UPG.

No need wait SIUP* key. 
I haven't Upgrade keys. 

Install on 
SIFLA9WRC7060*.EKB 
WINCC-V6 RC 256K PTg 512 
ATg

see more about upgrade keys

CAL license Top Previous Next

Question:
If it is the license from Microsoft as the information on presence CAL of the license is entered into a computer-client, in fact on it there are no installations MS SQL Server, 
especially, ALM? 
In what kind it is bought the CAL-license (is delivered)? 
The answer:
The license for a paper. Accordingly, she is not entered neither into a computer, nor in ALM.

Installation of Trial keys Top Previous Next

For some programs it is possible to install temporary Trial keys for the term of from several o'clock about a year of work.

A SITT*.EKB Trial License Key is installed from the CD. 

It can be activated via the actual SIMATIC application once for 14 days and is for evaluation purposes. 

You cannot restore or move the Trial License Key, but you can remove of Trial keys and their traces  and reinitialize Trial key anew.
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During installation of a temporary key in catalogues Windows and Windows \System32 catalogues *attis with one empty file are created.
Temporary key SITTA*.ekb is installed in catalogue C: \AX NF ZZ

After the ending of term of work it is necessary to remove Trial keys and their traces.
Otherwise problems are possible at work of normal keys.

Remove Trial keys (official) Top Previous Next

http://support.automation.siemens.com/WW/view/en/24200966

How can you deactivate the Trial License when the message appears indicating that the Trial License has expired, although the Floating License has been 
installed? 

Instructions:
Once activated the Trial License is valid for limited use up to a maximum of 14 days of the SIMATIC Software for tests, for example. If after expiry of this time 
you install a license for unlimited use (Single, Floating or Upgrade License) and after installation you still receive the message indicating that the Trial License 
has expired, we recommend deleting the Trial License in the "AX NF ZZ" folder.

Procedure for deleting a Trial License

1. Open the ALM in MS Windows via 

and mark the drive (e.g. "C") on which your licenses are installed. Displayed in the right window of the Automation License Manager is the table of the licenses 
installed. For viewing the licenses you need the file name (License Key) and the 20-digit license number. If these columns are not yet displayed, then via 

you open the "Define View" dialog. In the bottom section of this dialog you select the "Columns" tab and then "License key" and "License number".

Fig. 01 

Then you enter a name under "Edit view" and click the "Apply" button. Acknowledge with OK and the "License key" and "License number" columns appear in 
the Automation License Manager.

2. In the Explorer you mark the "AX NF ZZ" directory on your hard disk or on drive "C", so that the file names of the licenses are displayed in the right window 
of the Explorer. 

If the "AX NF ZZ" directory or the files in that directory are not visible, then open the dialog "Tools > Folder options..." and select the "View" tab: 

Then click on the "Apply" button and acknowledge with "OK". 

· "Start > SIMATIC > License Management > Automation License Manager"

· "View > Define..."

· Here you deactivate the option "Hide protected operating files (Recommended)" and 

· Activate the option "Show hidden files and folders".
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Fig. 02 

The "AX NF ZZ" directory is then displayed in the Explorer.

3 Now in the Automation License Manager compare the file name (License Key) of the Trial License with the file name in the "AX NF ZZ" folder. Via the view 
set in the Automation License Manager you determine the file name for the Trial License to be deleted (Fig. 03) that you then find in the "AX NF ZZ" folder.

Fig. 03

4 Mark the Trial License found in the "AX NF ZZ" directory and right-click. Then select "Delete" in the pop-up menu that opens. After deletion the message 
described above will no longer appear.

But need also: Removal of Trial keys and their traces

Removal of Trial keys and their traces Top Previous Next

After the ending of term of work it is necessary to remove Trial keys and their traces.
Otherwise problems are possible at work of normal keys.

After removal of Trial keys and their traces it is possible to install Trial keys again

See also: How can you deactivate the Trial License

Check of keys after installation Top Previous Next

After installation of keys it is required to lead procedure of check of a key in program ALM.
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Otherwise in some cases at start of the program you can see the warning of absence of a key which you have just installed.

License Number Top Previous Next

License Number
The license number is the unique identifier of a license.

There are 2 lines for input of serial numbers, so-called ID KHE, usually specified on yellow license diskettes and applied certificates.

10 symbolical number is intended for short keys.
20 symbolical number is intended for long keys.
You can not change these numbers, and give it to make to the program 

or select one of the available serial numbers of installed keys in the drop-down list box.

Select disk Top Previous Next
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Storage Location for License Keys
You can store license keys on storage media such as license key diskettes (for authorizations, on authorization diskettes) or on removable drives (but not on CD, 
CDRW) or USB memory sticks. 

License keys can be located locally on your own computer as well as on a network computer.

Drive (hard disk, floppy drive, USB memory stick) on a computer (My Computer or network computer) where a license key is or can be stored.

Choose a disk for installation of keys by means of the dropping out list.

In case of if during work it is inserted or the replaceable carrier{bearer} is taken out (for example USB Flash) it is required to press on the button " To update the list "

After that in the list the current set of disks will be displayed.

There are restrictions of programs of authorization AuthorsW and ALM.
Short keys cannot be transferred{carried} on the replaceable carrier and to install from it.

Yellow disk Top Previous Next

As from STEP 7 V5.4 SP2 the license is supplied on a USB stick.

The button of a call of a window for work with images of Yellow diskettes

By means of this utility it is possible to create Yellow a diskette from images of several types:
IMA, IMZ* - WinImage
IMG - FloppyImage
BIN - FDA (Floppy Disk Analyzator for DOS)
*Compressed images in format IMZ (WinImage) should be unpacked preliminary in a file with expansion IMA.
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On end of record the "license" path will be formatted. 
At the moment Siemens for this purpose uses tracks from 71 up to 79. 

If you have already created Yellow a diskette in other program (in the same WinImage or FloppyImage), 
That you can format separately separately a "license" path, having pressed on a corresponding cell.

Correctness of creation of a diskette can be checked up in the program of authorization AutorsW or ALM, 
Having chosen check of integrity of any key.
On characteristic "gnash" of the step-by-step engine of moving of a head it is possible to define{determine} also about success of procedure.
If you will not hear "gnash" - the diskette means was created incorrectly or the necessary path has not been formatted.
In this case can format consistently paths from 71 up to 79 and check in integrity in ALM.

For reading firm Yellow diskettes in a file-image can use the button " Read Yellow Disk " or consider{count} through program WinImage.
At attempt of reading of "license" path WinImage will give out the prevention{warning} of a mistake{an error} of reading. Press button " Ignore " for continuation of creation of an 
image. Can remember number of this path for formatting in our program.

If the error of reading has occured in the beginning or the middle firm diskettes then this a diskette has already started to become unfit for use.
Diskettes written down by program FDA contain many paths wrongly formatted non-standardly - also ignore these errors.
Not leaving from WinImage you can just write down the received image on duplicating a diskette and then to format a "license" path in our program.

For some programs (in particular WinCC and WebNavigator) from a diskette it is possible to install only SISLA keys.
On what that to reason SIFLA* keys are ignored at installation - their names are rigidly hammered in Setup.

Yellow Flash Top Previous Next

As from STEP 7 V5.4 SP2 the license is supplied on a USB stick.

At use of program ALM began possible{probable} to apply as the carrier of long keys Flash memory.
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You can transfer long keys on Flash memory and by means of program WinImage to make an image of this Flash, and then to restore all keys from this image Flash memory of 
any type and the size.

ALM Top Previous Next

The Automation License Manager is a product of Siemens AG Automation & Drives Group.

It is used to manage license keys (the technical form of licenses). 

Software products requiring a license key automatically report this requirement to the Automation License Manager. 

When the Automation License Manager finds a valid license key for this software, the software can be used in conformity with the end user license agreement.

It is developed in connection with release of version ALM 3.0 - the Authorization Licenses Manager after whom, so-called, "fastcopy" long keys of authorization have ceased to 
work because of their ignoring by this Authorizator.
"Fastcopy" keys could be copied simply in the directory of licenses C: \AX NF ZZ. They used auxiliary "hole" in system of authorization ALM <v3.0 which have been covered 
with output Step7 v5.4 SP1. 
Also additional coding the keys, therefore new keys have been applied are not visible in ALM v2.2.
New keys are not visible in ALM v1 and v2.
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transferring a license key to a PC without floppy disk drive Top Previous Next

What options are there for transferring a license key to a PC without floppy disk drive? 

Configuration Notes:
For some time now computers have been produced without a 
floppy disk drive. However, in order to install certain 
automation software products you need a floppy disk drive to 
install the license keys supplied on floppy disk. 

Using the Automation License Manager you can install the 
licenses on a PC without floppy disk drive as follows.

Transport Medium

License 
Key Type

Authorization
(e.g. 
STEP 7 
V5.2)

License Key
(e.g. Floating License 
Key STEP 7 V5.3)

External floppy disk drive with USB interface X X

USB stick as transfer medium from one computer with floppy 
disk drive to a computer without floppy disk drive

-- X

Second computer with floppy disk drive in the company 
network and transfer via the network

X1) X1)

Second computer with floppy disk drive and offline transfer
(see Help of the Automation License Manager)

X1) X1)

1) The Automation License Manager must also be installed on 
both computers. 

Note:
You can recognize a License Key in the Automation License 
Manager by the twenty-digit license number.
An authorization has a ten-digit license number. 

Multikey Top Previous Next

Page 20 of 33English

2/21/2020file:///C:/Users/PC-210A/AppData/Local/Temp/~hh8604.htm



Problems Top Previous Next

List index out of bounds
Problems with ALM v3.0 HF3
Problems with WinCC
Problems with WinCC Archive v6.2
Problems with PCS7 v7
I need SIUPA9WRC5--3 POWERPACK (upgrade) KEY ?

key_for_PCS7_v8.0 Top Previous Next

Part of the key branches in PCS7 v8.0
another part can be taken from branches WinCC v7.0

In v8.0 improved diagnosis, associated with the keys - so you probably will be easier to find the missing keys

After installation of the key need testing of keys in the ALM and restart WinCC

PCS7 v8.0 and key9999 Top Previous Next

SIFLP7OSRE0800 + SIFCYP7ORT9999*
bundle key "SIFLP7OSRE0800"  "OS Server Redundancy" 
include keys:
"SIFLP7REDU0800" "OS Redundancy"
 "SIFLP7SERB0800" "OS Server Basic"
 "SIFLP7SISB0800" "OS Single Station Basic"

Page 21 of 33English
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SIFLP7OSES0800 + SIFLP7OSES0800
bundle key "SIFLP7ASES0800" "AS Engineering"
include keys:

bundle key "SIFLP7OSES0800" "OS Engineering"
include keys:

 "SIFLA171040505" "Step 7 5.5" 
 SIFLA1CFCU0800" "CFC unlimited 8.0"
 "SIFLA1DOCP0504" "DocPro5.4"
"SIFLA1SCL_0503" "SCL 5.3"
"SIFLA1SFC_0800" "SFC 8.0"
"SIFLA1THPO0800" "TH-PO 8.0" 

"SIFLP7OSEB0800" "OS Engineering Basic"
"SIFLP7REDU0800" "OS Redundancy"
"SIFLP7SERB0800" "OS Server Basic"

License concept PCS 7 V7 Top Previous Next

Page 22 of 33English



Problems with PCS7 v7 Top Previous Next

You can try use these keys for PCS7 v7.0 (SP1)

when you run OS WinCC from PCS7 you required WCP RC PO key
when you run OS WinCC from WinCC you required WRC  RC key

PO = Power Objects = Tags for WinCC

Process Control System PCS 7 V7.0 SP1
PC Configuration and Authorization
https://support.automation.siemens.com/WW/llisapi.dll/csfetch/27002558/ps7pck_b_en-US.pdf

New keys Top Previous Next

Keys for some new Simatic programs will appear in the list only after installation of these Simatic programs on your computer.
For example - new key for new version of Teleservice

Ключи для некоторых новых программ появятся в списке только после инсталляции этих программ на ваш компьютер.
Но для некоторых новых ключей возможно фантомное дублирование в списке новых несмотря на то, что они уже есть в обычном списке - это связано с новой 
методикой имениобразования тэговых ключей для последних версий программ.

List index out of bounds Top Previous Next

Problem: 

When run the application in my computer come out error window. 
In another computer computer the application running correctly. 
This are the print screen of the error. 



I had the same problem as the one described on your web page.

Access violation at address 004BDF4E in module 'Sim_EKB_Install_2007_11_27.exe'. Read of address 00000000

I have a laptop with only one harddrive no floppydrive.

When I start the program it makes the "access violation" error, 

when I then add an usb drive the program can start.

It seems like the program wants to select disk number 2 in the dropdown box, it would normaly be the "c" drive but only if you have a floppy drive installed.

I also have a laptop with only one harddrive no floppydrive,

buty I divide a disk into 2 partitions C:\ and D:\.

Therefore I do not see similar errors

"in Russian"

Эта проблема проявляется на нотебуках без гибкого дисковода и с жёстким диском только с одним разделом.
Так как у меня тоже есть нотебук без дисковода, но жёсткий диск всегда поделён на несколько разделов, то я этой ошибки не замечал.

Problems with ALM v3.0 HF3 Top Previous Next

On some computers right after installations of updating of program ALM 3 HF3 (from Step7 v5.4 SP2) can arise problems with working capacity of original and 
not original keys. 
The reason of an error while is unknown. 

Method of the decision of a problem. 
1. Reload a computer. 
2. Check up keys through program ALM. 
3. Try to reinstall program ALM. 
4. Reinstall keys. 
5. Deinstall the new version of the program and install previous version ALM 3 HF1. 

Problems with ALM v5.0 Top Previous Next

v2010.05.09 



! all previous versions may fail if the drive installed the new version of the ALM v5 keys !
error will be corrected in future versions

Because of the new release ALM v5 may be many intermediate versions as far as finding new challenges.

BATCH Top Previous Next

Calculating the units for the BATCH station
License key for BATCH station
A defined number of units can be operated and monitored with this license key. 
The number of units that can be processed depends on the utilization of the BATCH server.
Example: BATCH Server (20)
The license key for BATCH server is adequate for configuring up to 20 units.

Requirement
● SIMATIC Manager is open.
Procedure
1. In the SIMATIC Manager, select the multiproject/project for which you want to calculate
the number of configured units.
2. Select the menu command Options > SIMATIC BATCH..
.The "Configure BATCH Process Cell" dialog box opens.
3. Select the "BATCH Process Cell" folder in the tree view.
4. In the "Process Cell" section, click "Check validity".
5. In the "Log" group, enable the "Validate" check box.
6. Click the "Display" button.
Result
A log file opens in the Internet Explorer.
● If the "Check validity" or "Compile" function shows an error in the configuration, you will need to correct the error and calculate the process objects again.
● If the configuration is free of errors, you will find the number of units configured in the multiproject/project in the table under the heading "Units".
● You can calculate the number of configurable units based on the license keys through the Automation License Manager.
Example of the layout of a log file:

Plant Units Log Date, time Result

<process cell name> 11 Plausibility <date, time> 0 errors, 0 warnings

No. ID Error Warning Remedy



CFC: AS License key for engineering Top Previous Next

License key for the AS
The required license key for all SIMATIC stations depends on the total number of process objects loaded and configured in a project (multiproject).
When an AS is loaded, the loaded process objects are evaluated. 
The following procedure shows you how to calculate the number of process objects configured in a project. 
With a multiproject, you need to determine the number per project and add them together.

The following applies as of PCS 7 V7.0 SP1:
The number of process objects loaded into the AS is calculated and subtracted from the available process objects (countable license keys).
You calculate the number of available (still to be loaded) process objects using the license key via the Automation License Manager or in SIMATIC Manager via the menu 
command
Options > Charts > Process Objects Statistics.

Display
The display of the number of licenses is based on the object selected in the SIMATIC Manager (multiproject, project, SIMATIC station).
Requirement
The SIMATIC Manager is open.
Procedure
1. Select the multiproject in the component view.
2. Select the menu command Options > Charts > Process Objects Statistics.
The "Process Objects Statistics" dialog box opens.

Result
The "Process Objects Statistics" dialog box shows the number of configured process objects, the existing license, and the process objects which are currently still available for 
the following system areas:
● Multiproject
● Project
● SIMATIC station

AS License key for engineering
Relevant process objects in the project are process objects that can be monitored with the OS.
The license key for engineering provides the number of process objects that you can configure in the CFC as "process objects in the project".

Procedure
You can calculate the number of configured process objects as follows:
1. Open any chart in CFC.
2. Select the menu command Options > Chart Reference Data.
The "Chart Reference Data" dialog box opens.
3. Select the menu command View > Statistics.
Result
You will find the number of "Process objects (PO) [x]" and the scale of the license key in the "process objects in the project" path. 
The following figure shows an example.



Route Control Top Previous Next

Calculating the routes for the route control station
License key for route control station
For the process mode of SIMATIC Route Control, the number of active routes (material transports) is relevant and not the number of configured routes. The number of routes 
active in process mode is based on the process.

Example: Route Control Server (300)

This is the license key for a route control server in which 300 routes can be simultaneously active in process mode.

Determining the route license
The status bar of the Route Control Center shows how many routes were active simultaneously after a restart of the route control server.

License key too small – server license key is installed
Note
If the route control server detects a license key for 30, 100 or 300 routes during startup, the maximum number of simultaneous material transports will be limited to this value. 
If the server then receives a 31st, 101st or 301st route request, the Route Control Center reports that the license key is missing or that the limit has been exceeded. 
The route control server continues to operate.

License key too small – server license key is not installed
If no license key is installed on the route control server, the server is limited to a maximum of 300 routes (maximum limit). 
Since information about the actual size of the system is lacking on the route control server, it makes an estimate on the safe side - you can continue to operate the system even 
when there is no license. 
The absence of a license is displayed in the Route Control Center.

New license
Restart the route control server after you have installed the license.

Long name License name

SIFLA7RCS30700 Route Control Server 300 simultaneous

SIFLA7RCS20700 Route Control Server (100)

SIFLA7RCS10700 Route Control Server 30 simultaneous

SIFLA7RCEN0700 Route Control Engineering

SIFLA7RCCX0700 Route Control Center

Problems with WinCC Top Previous Next

For some programs (in particular WinCC and WebNavigator) from a diskette it is possible to install only SISLA keys.
On what that to reason SIFLA* keys are ignored at installation - their names are rigidly hammered in Setup.

See LogFiles in C:\Program Files\SIEMENS\WINCC\Diagnose
for example License.Log when License key A9WRC installed
02/01/2007 13:16:50 InitLicense CS | AppName = AppCS:Mcp | CycleCheck = yes | NameForMessageBox =  | Name of License = SIFLA9WRC70600 | Text of License = 
WinCC RC (262144) | 
02/01/2007 13:16:50 InitLicense ED | AppName = AppEd:Mcp | CycleCheck = own | NameForMessageBox =  | Name of License = SIFLA9WRC70600 | Text of License = 
WinCC RC (262144) | 
02/01/2007 13:17:07 InitLicense RT | AppName = OptRT:CHIPCARD | CycleCheck = no | NameForMessageBox =  | Name of License = SIFLA1WPC40600 | Text of License = 
WinCC Chipcard | 
02/01/2007 13:17:07 ExitLicense RT | AppName = OptRT:CHIPCARD | CycleCheck = no | Name of License = SIFLA1WPC40600 | Text of License = WinCC Chipcard | 
02/01/2007 13:17:08 InitLicense CS | AppName = AppCS:TlgASO | CycleCheck = yes | NameForMessageBox =  | Name of License = SIFLA9WTG30600 | Text of License = 
WINCC Archive (30000) | 
02/01/2007 13:18:48 InitLicense xx | AppName = ConnectivityPack | CycleCheck = no | NameForMessageBox =  | Name of License = SIFLA9WOP10600 | Text of License = 
WinCC Connectivity Pack | 
02/01/2007 13:18:48 ExitLicense xx | AppName = ConnectivityPack | CycleCheck = no | Name of License = SIFLA9WOP10600 | Text of License = WinCC Connectivity Pack | 
02/01/2007 13:30:15 ExitLicense CS | AppName = AppCS:TlgASO | CycleCheck = yes | Name of License = SIFLA9WTG30600 | Text of License = WINCC Archive (30000) | 
02/01/2007 13:30:17 ExitLicense CS | AppName = AppCS:Mcp | CycleCheck = yes | Name of License = SIFLA9WRC70600 | Text of License = WinCC RC (262144) | 
02/01/2007 13:30:17 ExitLicense ED | AppName = AppEd:Mcp | CycleCheck = own | Name of License = SIFLA9WRC70600 | Text of License = WinCC RC (262144) | 



Example when installed 2 License key A9WRC.
Low key with 128 tags block High key with 65536 tags

Example  License.Log when installed 2 License key A9WRC.
02/01/2007 14:39:29 InitLicense CS | AppName = AppCS:Mcp | CycleCheck = yes | NameForMessageBox =  | Name of License = SIFLA9WRC10600 | Text of License = 
WinCC RC (128) | 
02/01/2007 14:39:29 InitLicense ED | AppName = AppEd:Mcp | CycleCheck = own | NameForMessageBox =  | Name of License = SIFLA9WRC10600 | Text of License = 
WinCC RC (128) | 
.....

You need use only one key with max Tags

Example License.Log when License key A9WRC not installed

for example Authorinformation.inf  when License key A9WRC* not installed

and part of License.Log when License key A9WRC* not installed
02/01/2007 14:10:20 Control Center - Demo Mode ConfigurationSystem enabled -
02/01/2007 14:10:20 NoLicense CS | Name of License = A9WRC?0600 | Text of License = Simatic WinCC RC (Runtime + Development) | Exists = No | 
02/01/2007 14:10:20 InitLicense CS | AppName = AppCS:Mcp | CycleCheck = yes | NameForMessageBox =  | Name of License = A9WRC?0600 | Text of License = Simatic 
WinCC RC (Runtime + Development) | 
02/01/2007 14:10:22 NoLicense ED | Name of License = A9WRC?0600 | Text of License = Simatic WinCC RC (Runtime + Development) | Exists = No | 
02/01/2007 14:10:22 Control Center - Demo Mode Editors enabled -
02/01/2007 14:10:22 InitLicense ED | AppName = AppEd:Mcp | CycleCheck = own | NameForMessageBox =  | Name of License = A9WRC?0600 | Text of License = Simatic 
WinCC RC (Runtime + Development) | 
.....

License installed needed        to install Product
SI--A9WRC?---- No Yes Yes Simatic WinCC RC (Runtime + Development) 
SIFLA9WSN40600 Yes Yes No WebNavigator 50 Clients
SIFLA9WOP10601 Yes No No WinCC Option Connectivity Pack
SIFLA9WSPA0600 Yes No No ProAgent WinCC

WinCC: the number of process objects Top Previous Next

If you have executed the "Compile OS" function in SIMATIC Manager, you can determine the number of configured process objects in the WinCC Explorer:
Determining the number of process objects
1. Select the OS in the WinCC Explorer:
The number of configured process objects is displayed at the bottom right of the dialog box.
The screenshot below shows an example with "578 process objects".

Insufficient license key
If you open a project with an insufficient number of configurable process objects, the OS program switches to demo mode automatically.
If an RT/RC license key is present, the maximum number of configurable process objects is always permissible on a client, as the number of configurable process objects is 
only checked on a server.

Long name License name Version

SIFLA9WRC90700 WinCC RT PO (unlimited) v7.0

SIFLA9WRC80700 WinCC RT PO (20000) v7.0

SIFLA9WRC70700 WinCC RT PO (10000) v7.0



SIFLA9WRC60700 WinCC RT PO (8500) v7.0

SIFLA9WRC50700 WinCC RT PO (5000) v7.0

SIFLA9WRC40700 WinCC RT PO (3000) v7.0

SIFLA9WRC30700 WinCC RT PO (2000) v7.0

SIFLA9WRC20700 WinCC RT PO (1000) v7.0

SIFLA9WRC10700 WinCC RT PO (250) v7.0

SIFLA9WRC00700 WinCC RT PO Client v7.0

WinCC: the number of archive values Top Previous Next

License key for archive values
This license key allows you to archive a defined number of archive values with the operator station. 
The basic package is supplied with a license key for 512 archive values.
The license key required for archiving archive values in the OS project depends on the number of values configured for archiving.

Open the "Tag Logging" editor in the WinCC Explorer.
The number of configured archive values is displayed at the bottom right of the dialog box.
The screenshot below shows an example with 129 of 10,000 authorized archive values.

Example: WINCC User Archives (10000)
This license key enables you to increase the number of archive values which can be configured for the archive server to 10000 (max. 30000)

Insufficient license key
If you open a project with an insufficient number of configurable process objects, the OS program switches to demo mode automatically.
If an RT/RC license key is present, the maximum number of configurable process objects is always permissible on a client, as the number of configurable process objects is 
only checked on a server.

Short name Long name License name Version

977 A9WARC70 SIFLA9WARC0700 WINCC User Archives v7.0

978 Y9WTG670 SIFCY9WTGX07006 WINCC-V7 Arch 80000 ATg v7.0

979 Y9WTG570 SIFCY9WTGX07005 WINCC-V7 Arch 10000 ATg v7.0

980 Y9WTG470 SIFCY9WTGX07004 WINCC-V7 Arch 4G ATg UNLIM v7.0

981 Y9WTG370 SIFCY9WTGX07003 WINCC-V7 Arch 30000 ATg v7.0

982 Y9WTG270 SIFCY9WTGX07002 WINCC-V7 Arch 5000 ATg v7.0

983 Y9WTG170 SIFCY9WTGX07001 WINCC-V7 Arch 1500 ATg v7.0

1024 Y9WTG770 SIFCY9WTGX07007 WINCC-V7 Arch 120000 ATg v7.0

WinCC CAS Top Previous Next

Calculating the process objects for the central archive server
The archive values of all OS servers in a PCS 7 plant are archived on a central archive server. 
The sum of the archive values of all OS servers gives the number of licensed archive values.

License keys for the central archive server
The following license keys are required for the central archive server:
● License key for operating an OS client: SIFLA9WRP00602 WinCC RT PO Client ; SIFLA9WCP70700   WINCC-V7 RC PO (10000)
● License key for the "StoragePlus" software package: SIFLA1STOP0102 StoragePlus
● To use the central archive server: SIFLA9WSEC0700 WinCC Server
● To use the archives: SIFCY9WTGX07005  WINCC-V7 Arch 10000 ATg; SIFLA9WARC0700 WinCC Archive
● To view archived data: SIFLA9WVC20707 WinCC DataMonitor 10 Clients

Determining the number of archive values on an OS server
1. Open the "Tag Logging" editor in the WinCC Explorer.
The number of configured archive values is displayed at the bottom right of the dialog box.
The screenshot below shows an example with 129 of 10,000 authorized archive values.

2. Determine the number of archive values of all OS servers.
If redundant OS servers are used, the number of archive values must be doubled.

WinCC Maintenance station Top Previous Next

Calculating the asset tags (hardware components) for the maintenance station
License key for WinCC Maintenance station
The license type of these license keys is "Count relevant license" SIFCYMAINR0700*. 

Short name Long name License name Version

739 MAINES70 SIFLMAINES0700 Maintenance ES V7.0 v7.0



The licensed scope is added together when several license keys are installed.
● This license key allows you to monitor a defined number of diagnostic objects (asset tags).

Example: SIFCYMAINR07004 Maintenance RT (100)
This license key is sufficient for diagnosing up to 100 hardware components with a maintenance station. 
If you have 3 Maintenance RT (100) license keys (with difference serial numbers !) on a maintenance station, 
you will be able to diagnose up to 300 (100+100+100) hardware components.

Components with diagnostics capability
The following components with diagnostics capability are classed as asset tags within a PCS 7 project:
● PC stations
● Network components with diagnostics capability (e.g., switches)
● Automation systems (CPU)
● Distributed I/O (ET 200 station)
● Field devices with diagnostics capability

Requirement
SIMATIC Manager is open.

Procedure
1. Select the multiproject in the plant view.
2. Select the menu command Options > Plant Hierarchy > Configured Objects.
The "Configured Objects" dialog box opens.

Result
The "Configured Objects" dialog box displays the number of configured diagnostic objects (asset tags).

740 YMAINR70 SIFLYMAINR0700 Maintenance RT V7.0 (unlimited) v7.0

741 YMAINR71 SIFCYMAINR07001 Maintenance RT V7.0 (10) v7.0

742 YMAINR74 SIFCYMAINR07004 Maintenance RT V7.0 (100) v7.0

1107 YMAINR75 SIFCYMAINR07005 Maintenance RT V7.0 (250) v7.0

767 YMAINR76 SIFCYMAINR07006 Maintenance RT V7.0 (500) v7.0

743 YMAINR77 SIFCYMAINR07007 Maintenance RT V7.0 (1000) v7.0

WinCC Demo mode Top Previous Next

Q: I have all keys, but WinCC wrote "Demo mode"



You need install ONLY 1 RC key.
In this time only low 128 Tags key is worked - others keys is banned !!!

remove another RC keys to floppy

Q: Thank you, I did not know that. It works good now

Problems with WinCC Archive v6.2 Top Previous Next

New for Archive Licenses 

For archive licenses, the new license type "Count-Relevant" is being introduced starting with WinCC V6.2. It enables a much finer stacking of the licenses. 

If, for example, a WinCC project uses a license for 1500 archive tags as well as a license for 5000 archive tags, then a total of 6500 archive tags are available on 
this computer. 
On the other hand, the 512 free archive tags included in the delivery scope of the basic packages are not added up. 

For using more 512 Archive Tags is required SIFCY9WTGX0600*
WinCC Archive v6.2

Select> Short name Long name License name Version

622 A9WARC62 SIFLA9WARC0602 WINCC User Archives v6.2

623 Y9WTG662 SIFCY9WTGX06026 WINCC-V6 Arch 80000 ATg v6.2

624 Y9WTG562 SIFCY9WTGX06025 WINCC-V6 Arch 10000 ATg v6.2

625 Y9WTG462 SIFCY9WTGX06024 WINCC-V6 Arch 4G ATg UNLIM v6.2



626 Y9WTG362 SIFCY9WTGX06023 WINCC-V6 Arch 30000 ATg v6.2

627 Y9WTG262 SIFCY9WTGX06022 WINCC-V6 Arch 5000 ATg v6.2

I need SIUPA9WRC5--3 POWERPACK (upgrade) KEY ? Top Previous Next

I need SIUPA9WRC5...3 UPGRADE WinCC runtime +conf. 1024-8k powerpack license key 

No need wait SIUP* key. 
I don't support Upgrade keys - in it there is no necessity. 

Install on SIFLA9WRC7060*.EKB WINCC-V6 RC 256K PTg 512 ATg
You can install normal long key SIFLA9WRC60*00.EKB (max 256K) from YELLOW FLASH or Yellow Disk SIFLA9WRC60*00.IMA 

Do not forget remove old key on smaller number of tags - differently it can to not give access to more powerful key.

Keys for updating the license consist of two keys *.EKB and *.UPG.
Example of a diskette for updating the version of the program.

Program required key after installation of key Top Previous Next

Before first start of SmartLabel need check installed key in ALM.
This is bug of SmartLabel and other Simatic programs.

About EKBBackup CRC Error Top Previous Next

About EKBBackup CRC Error 
This EKBBackup option is false - EKB_Install key haven't CRC error 
This EKBBackup version also have "Fix CRC" ERROR 
After this "Fix" I can't move "fixed" key to other disc.

EKBBackup 1.0.1.38 

ALM wrote after fix 

ALM show result after moving "fixed" keys - all moved keys inactive 



Other Key  programs (based on Fubrus souce) also haves this bug

for example this


